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Introduction

Welcome to FrameMaker, a self-contained document publishing 
system for the technical writing environment. Frame is designed to 
easily manipulate large amounts of data and graphics, from simple 
memos to multi-volume documents, making it the program of choice 
for the professional technical writer.

Frame contains a powerful set of authoring tools, specifically suited 
for long, complicated documents. Some of these features are:

• Paragraph and Character catalogs allow complete control over docu-
ment text. When exporting to a Portable Document Format (PDF) 
you know your document maintains the same look as when you cre-
ated it. 

• A flexible page design (Master Page) function permits complete cre-
ative control over your document which is limited only by your 
imagination.

• The capability of importing formats created in another Frame docu-
ment (a template) and applying them to another document. This 
permits you to remain consistent in style and layout from one docu-
ment to another. 

• The ability to assemble a set of documents and combine them into a 
project known as a book. 

• Frame provides the most comprehensive single-source concept 
available. Create once, use many times. Create your document and 
export to HTML for publishing to the web or CDROM. In addition 
you can save to other platforms, Mac or Unix should the need arise. 

• With PDF (Portable Document Format) output you can easily create 
documentation for the web or distribution on a CDROM.

Most FrameMaker books try to cover everything Frame has to offer. 
Not this book. This training is written specifically for the novice. 
Instead of trying to be an “everything about FrameMaker” book, I 
decided to concentrate on the basics: How FrameMaker works, how to 
put a document together, how to create a book, and how to create a 
PDF. I stay away from complex issues such as Structured formats, 
conditional text, and other complicated matters. 

Even when concentrating only on the basics, Frame’s learning 
curve is steep. In order to obtain the most out of the program you must 
be willing to invest time and effort to learn this remarkable program.
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Prerequisites

To benefit from this training you must have, and be familiar with, the 
following:

• Know how to use the Windows operating system and related com-
puter equipment, including printers. This training does not address 
the Mac or Unix environments.

• Know how to open, save, and close files in Windows. Know how to 
navigate to various directories.

• Know how to copy, paste, and move graphics into a specified direc-
tory.

• Know how to select, copy, move, delete, and cut text in a Windows 
environment.

• Know how to Control and Shift click to select and de-select single 
and multiple items.

• Have a basic knowledge of MS Word (version 97 or 2000 specifi-
cally). Understand how to open, save, and close Word documents. 
Know how to create text files.

• Access to a printer. A Postscript printer is recommended but not 
mandatory.

• Access to FrameMaker, Version 6.x, 7.0, or 7.1. While version 5.5 
works, there are changes in the programs, especially the book build-
ing feature, which requires a different way of instruction and is 
therefore not discussed.

• Access to a full version of Adobe Acrobat, minimum version 4.0 and 
the Distiller program that comes with Acrobat. Version 3.0 is NOT 
recommended and is not discussed. However, the steps I discuss to 
create a PDF file are also available in later versions of Acrobat. 
Acrobat Version 6 is the recommended program and the one that we 
will be working with.

• Acrobat Reader does not perform the functions required and is 
totally unusable for this training.

Version Differences

For the purposes of this training you can use either Version 6.x, 7.0, or 
7.1. There are some differences in the menus and other areas of the 
programs, however, for our purposes these differences are minor. 
Where and when they become a factor is when you begin to use the 
more advanced functions of FrameMaker.

Where there are differences of consequence between the versions I 
will point them out and explain them.

At the time this book was completed FrameMaker 7.2 was just 
entering the marketplace. Much of this training will apply to the latest 
version, however differences in the latest version are not discussed.
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Learning Objectives

Frame is considered a “complete” publishing system, and provides all 
the tools necessary for building a single book or a multi-volume book. 
But it goes far beyond that. You can create hypertext help systems and 
web pages using this versatile program. This training does not cover 
those “advanced” subjects but I will discuss (subjects listed in alpha-
betical order, not learning order):

How much benefit you obtain from these lessons is entirely up to 
you. The more time you invest learning, the more competent you 
become. I can only present the information, you must apply it.

Since the learning curve for this program is almost vertical, the 
explanations and examples presented in this training will help as you 
begin to master the power of FrameMaker.

* Book Building

* Character Designer and Font Catalog

* Cross Referencing

* Find and Replace

* Formatting

* Frame Interface

* Graphics

* Importing Text and Graphics

* Master Pages and Page Layout

* Paragraph Designer and Paragraph Catalog

* PDF, Creating

* Reference Pages

* Spell Check

* Table Designer and Tables

* Table of Contents, List of Tables, and List of Figures

* Templates

* Variables

* Word Processing



Introduction–4 Basic Training

FrameMaker Basic Training

Consistency

A word about consistency. As a desktop publisher or technical writer 
your job is to ensure each document you create is consistent with other 
similar documents. Your company, as a general rule, has probably 
established a style guide which you are required to follow when creating 
documents. There are sound business reasons for this which are far 
beyond the scope of this book, but relevant to the discussion of our 
topic. Therefore I talk about style guides and consistency in the latter 
part of this book. 

As a general rule you should always plan to keep your documents 
consistent from the beginning of any project. FrameMaker possesses 
the ability to maintain a consistent look and feel across individual files 
making this task much easier.

Getting Started

This book assumes you have no idea of how FrameMaker works. 
Therefore it is critical you spend some time on the first lesson. This 
lesson lays the foundation and introduces you to the working environ-
ment of the program. Time spent on the first chapter will pay divi-
dends as you progress through the training.
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Lesson 1.0  The FrameMaker Interface

To learn any new software program you must invest time and effort. 
The more time and effort you spend, the more proficient you become. 
Since Frame is a powerful program it requires this time investment to 
master.

The interface is the gateway for using FrameMaker. Frame begins 
with a simple interface which rapidly becomes complex. The primary 
interface window is displayed in Figure 1-1 and is the normal starting 
point when starting Frame.

The basic parts of the FrameMaker interface are:
• The Title Bar
• The Menubar
• The QuickAccess Bar
• The Formatting Bar
• The gray area is the primary holding space for a FrameMaker docu-

ment.

This lesson gives an overview of the interface features and subse-
quent lessons provide a more detailed explanation. Take time to famil-
iarize yourself with the contents of this lesson as time spent here 
enhances your understanding of Frame.

Objectives:  
At the end of this lesson the student will be able to:

1. Identify the various components of the FrameMaker Interface.

2. Identify the components of the Menubar.

3. Identify the components of the QuickAccess bar.

4. Understand the Preference dialog box.

5. Change units of measure.

6. Identify the components of the Shortcut Icons.
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Lesson 1
The FrameMaker Interface

1.1 Basics 

Frame uses many Windows-style keyboard commands, that is 
CTRL+A selects all, CTRL+C is the copy command, CTRL+Z is undo, 
and so forth. 

Frame also provides three toolbars to help you create and work 
with a document. These are:

• The Menubar – provides access to common commands and functions 
in Frame. There are some commands, however that must be 
accessed via other methods.

• The QuickAccess bar – provides many shortcuts to common com-
mands used in Frame. When you place your mouse over an icon, a 
text option box explains the purpose of the button. Simply click on 
the appropriate icon to launch the function.

• The Formatting bar – provides a quick way to format text and para-
graphs. It is extremely useful for creating documents “on-the-fly.”

1.1.1 The Undo 
Command

Frame only allows one undo. In other words if you make several errors, 
you can only undo the last error made. It acts as a toggle, it will undo 
your mistake, then reapply it each time you activate CTRL+Z. There 
are no multiple undo’s in FrameMaker prior to version 7.2. There are 
some commands that do not allow an undo. When you encounter one of 
these you are given a warning and an option to cancel the event.

1.1.2 Text 
Manipulation and 
Limitations

You cannot select text and move it with the mouse, you must cut and 
paste. Nor does Frame utilize automatic spell correction, or capitaliza-
tion as you type. However, even without these “niceties” you have 
additional control over your document, more so than with any word 
processor.

1.1.3 Starting 
Frame the First 
Time

The first time you start FrameMaker 7.x, you have a choice of inter-
face modes (Figure 1-2). This selection remains in effect until you 
change it in Preferences. You can also change modes via the Prefer-
ences window (Section 1.6.1). (Does not apply to FrameMaker Version 6 
or earlier.)
Figure 1-2  Initial Interface Selection
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A New FrameMaker Document

1.2 A New FrameMaker Document

Figure 1-3 illustrates a new FrameMaker document. Also displayed is 
the Paragraph and Font Catalogs. I shall briefly discuss each of these ele-
ments and provide a complete explanation in later lessons. 

Figure 1-3  A New FrameMaker Document
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Lesson 1
The FrameMaker Interface

1.3 Command Functions

Frame uses many of the same toolbars and menu functions found in 
other Window programs, but also has several unique functions which 
you must become acquainted with. Frame utilizes toolbars to help cre-
ate and work with a document. These are:

The Menubar (Figure 1-4): provides access to many of the commands 
and functions available in Frame. 

The QuickAccess bar (Figure 1-5): provides shortcuts to common com-
mands used in Frame and is a graphical subset of the Menubar. This 
bar also contains several elements not found in the Menubar.

The QuickAccess bar may be docked or floating according to your pref-
erence. Refer to Figure 1-18 for an illustration of the bar in floating 
mode.

The Formatting bar (Figure 1-6): allows quick format of text, place-
ment of tabs, and displays what paragraph tag is in use where the cur-
sor currently rest. These functions override the current paragraph set-
tings.

While not officially a toolbar, the Status bar (Figure 1-7) contains 
information about the document and provides controls for window 
zooming and movement through the document.

Figure 1-4  Menubar

Figure 1-5  QuickAccess Bar

Figure 1-6  Formatting Bar

Figure 1-7  Status Bar
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1.3.1 The Menubar The Menubar provides access to most of the commands and functions 
used in FrameMaker. 

Note: When an item is “greyed out” it indicates that selection is not 
available at this time. Menu items change their status from 
inactive to active depending upon the particular function 
involved.

Many of the items in the Menubar has an equivalent keyboard com-
mand, which you may find easier to work with. Some examples are:

• ALT+F+N provides access to the new document or book command,
• CTRL+S saves the current document, and 
• CTRL+P opens the print dialog box. 

1.3.1.1 The File 
Command Menu

The File command (Figure 1-8) provides access to numerous functions, 
including creating new documents and books.

Figure 1-8  The File Command Menu
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Section 1.3 Command Functions 1–7

Lesson 1
The FrameMaker Interface

The commands and functions are described in Table 1-1.

Note: Holding the SHIFT key while clicking on the File menu opens 
a different menu system at the book level. This alternate 
menu system is discussed at a later time.

Many commands open additional dialog boxes, which are explored 
throughout this training. However some commands fall outside the 
scope of this training and are not discussed.

Table 1-1  The File Commands 

Command Function

New Create a new document or new book.

Open... Opens a file.

Close Closes a file. Will prompt to save changes.

Save Save a file.

Save As... Save the file with a new name or type.

Revert to Saved Returns to the previously saved version of the 
document or book.

Import Import a file, format, or object.

Workgroup Internet function. Not discussed.

Links Internet function. Not discussed.

File Info Establish Metadata information for a file or book.

Print Print a document or book.

Print Setup Select printer, paper, and document orientation.

Send Send a document via email.

Webworks 
Standard Edition

Create and publish web pages.

Utilities Provides a submenu and set of functions. 

Preferences Sets User Preferences [General...].
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1.3.1.2 The Edit 
Menu

The Edit menu is illustrated in Figure 1-9 and provides functions for 
editing the document.

The commands and functions of the Edit menu are described in 
Table 1-2.

Figure 1-9  The Edit Menu
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Table 1-2  The Edit Menu 

Command Function

Undo [element] Undo the last action taken. 

Cut Cut text or graphics.

Copy Copy text or graphics.

Paste Paste elements that were cut or copied.

Paste Special Provides more options than the Paste command.

Clear Clear selected text or items.

Copy Special Opens submenu to copy special elements.

Select All in Flow Selects all elements in the flow you are currently 
in. 

Find/Change Opens the find/change dialog box.

Find Next Find the next occurrence of the element you are 
searching for.

Spelling Checker Check document or book level spelling.

Thesaurus Open the thesaurus dialog box.

Text Inset Properties Allows you to change the properties of imported 
text.

Update References Allows you to update references.

Links Link to files or URLs. Not discussed.

Object Allows you to manipulate an imported graphic.
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1.3.1.3 The Format 
Menu

The Format menu is illustrated in Figure 1-10. This menu contains 
numerous submenus so only a basic description is discussed here 
(Table 1-3).

Note: The Format menu is comprehensive and discussed later.

Figure 1-10  The Format Menu

Table 1-3  The Format Menu

Command Function

Font Select a font. Opens a font listing.

Size Select a font size. Opens a font size menu.

Style Select a font style. Opens style menu.

Characters Select and apply a character format. 

Paragraphs Select and apply a paragraph format.

Page Layout Establish the layout of the page.

Customize Layout Customize the page and text frames.

Document Set document characteristics.

Headers & Footers Manipulate header and footer information.
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Lesson 1
The FrameMaker Interface

1.3.1.4 The View 
Menu

The View menu is illustrated in Figure 1-11. A check mark indicates 
the item is active and/or visible. The Options and Go to Page selections 
open additional dialog boxes. The Options dialog box provides measure-
ment and units (pica, points, inches, etc.) applicable to the document.

Note: The Menu selection is not discussed as it is beyond the scope of 
this training.

1.3.1.5 The Special 
Menu

The Special menu is illustrated in Figure 1-12. Table 1-4 describes 
the functions of the special menu.

Figure 1-11  The View Menu

Figure 1-12  The Special Menu
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Table 1-4  The Special Menu

Command Function

Page Break... Insert a page break.

Anchored Frame... Insert an anchored graphic frame.

Footnote... Insert a footnote.

Cross-Reference... Insert a cross-reference.

Variable... Insert a variable.

Hypertext... Insert hypertext.

Marker... Insert a marker.

Equations... Open the equations editor.

Conditional Text... Open the conditional text dialog box. Not 
discussed in this training.

Table of Contents... Create a table of contents.

List of Submenu of items you can create a list of.

Standard Index... Create an index.

Index of Submenu to create various indexes.

Add Disconnected Pages... Add new pages to document.

Delete Pages... Delete pages from document.
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Lesson 1
The FrameMaker Interface

1.3.1.6 The 
Graphics Menu

The Graphics menu is illustrated in Figure 1-13. Elements in this menu 
are discussed in the graphics lesson.
Figure 1-13  The Graphics Menu
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1.3.1.7 The Table 
Menu

The Table menu (Figure 1-14) provides the commands for creating and 
manipulating tables.

Table 1-5 describes the functions of the table menu.

Figure 1-14  The Table Menu

Table 1-5  The Table Menu

Command Function

Insert Table... Insert a new table in the document.

Table Designer... Open the table designer.

Row Format... Open the row format dialog box and 
manipulate the properties.

Custom Ruling & Shading... Open the ruling and shading dialog box 
and manipulate the properties.

Add Rows or Columns... Add rows or columns to the table.

Resize Columns... Open the column dialog box and 
manipulate the properties.

Straddle... Merge two or more rows or columns

Convert to Paragraphs... Convert the table to normal text.

Sort... Sort the table.
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1.3.1.8 The 
Window Menu

The Window menu is illustrated in Figure 1-15. This menu provides 
quick access to any other open document. A checkmark indicates 
which document is active. You can only work in one document at time.

1.3.1.9 The Help 
Menu

The Help menu is illustrated in Figure 1-16.

Figure 1-15  The Window Menu

Figure 1-16  The Help Menu

Table 1-6  The Help Menu

Command Function

Help Topics... Open the help window.

Support... Opens the Adobe Support web page.

Updates... Checks for program updates.

Registration... Register FrameMaker online.

Adobe Online... Opens various portions of the Adobe 
website.

About FrameMaker... Provides information about Frame.
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1.4 The QuickAccess Bar

The QuickAccess bar displays common commands. You can dock or float 
the QuickAccess bar by clicking the Flip QuickAccess Bar option (Figure 
1-17). Click once to float, click again to dock.

Note: If you float the QuickAccess bar, the icons may change appear-
ance when you toggle through the bars. However, the com-
mands and functions remain the same.

Four access bars are capable of being displayed, one-at-a-time. 
These bars are the: 

• Text Editing bar
• Graphics bar
• Graphics Editing bar
• Table Editing bar

Note: There are third party programs that can change the appear-
ance of, and add functions to, the QuickAccess bar and 
Menubar. These third party programs (known as plug-ins) 
make working with Frame much easier, but are not discussed 
in this training as not everyone may have need of, or desire 
for, these programs. Therefore we will stick strictly to the com-
mands and functions supplied by the default installation.

The first twelve buttons on the QuickAccess bar are known as the 
common commands (Figure 1-17) and provide quick access to various 
functions common to most Window applications. The Previous and Next 
buttons cycle through the remaining bars which are illustrated in the 
following pages.

Figure 1-17  QuickAccess Bar Common Commands
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1.4.1 Text Editing 
Bar

The Text Editing components of the QuickAccess Bar are shown in Figure 
1-18. This is the bar you work with when manipulating text.

Note: The icons displayed on the text editing bar, when in floating 
mode, may be different than when the toolbar is docked. How-
ever, the commands remain the same.

Figure 1-18  QuickAccess Text Editing Bar and Components
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1.4.2 The Graphics 
Bar

The Graphics Bar (Figure 1-19) must not be confused with the Graphics 
Editing Bar. 

These icons provide commands and functions for graphics. 

Note: The icons displayed on the graphics bar, when in floating 
mode, may be different than when the toolbar is docked. How-
ever, the commands remain the same.

Figure 1-19  QuickAccess Graphics Bar
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1.4.2.1 The 
Graphics Editing 
Bar

The Graphics Editing Bar (Figure 1-20) is not to be confused with the 
Graphics Bar. 

These icons provide commands and functions for graphics editing. 

Note: The icons displayed on the graphics editing bar, when in float-
ing mode, may be different than when the toolbar is docked. 
However, the commands remain the same.

Figure 1-20  QuickAccess Graphics Editing Bar
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1.4.2.2 The Table 
Editing Bar

The Table Editing Bar (Figure 1-21) provides the commands and func-
tions for table editing.

Note: The icons displayed on the table editing bar, when in floating 
mode, may be different than when the toolbar is locked in 
place (i.e. flipped up). However, the commands remain the 
same.

Figure 1-21  QuickAccess Table Editing
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1.5 The Status Bar

The Status Bar (Figure 1-22) provides information about the document. 
The items located on this bar consist of the:

• Current Flow
• Current Paragraph tag
• Character tag in use (when appropriate)
• Current page, and total number of pages
• Zoom Commands

Note: Flow, character, and paragraph tags are discussed, in detail, 
later in this training, so I will not duplicate that information 
here. 

The Status Bar informs you what the current page is, and how 
many pages are in the document. The asterisk is a quick visual refer-
ence informing you that the document is not saved. You can also page 
up or down by clicking on the Page Up or Page Down arrows.

1.5.1 Zoom 
Commands

You can enlarge the viewing area of a document (zoom in) or decrease 
the viewing area (zoom out) by using the Zoom controls. Zoom com-
mands are located in the status bar as illustrated in Figure 1-22. You 
may zoom in and out of a document by using either the zoom in and 
out buttons or the zoom pop-up menu button.

Figure 1-22  Status Bar
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The zoom pop-up menu (Figure 1-23) allows you to set the magnifi-
cation percentage to any value starting at 25% to a maximum of 
1600%. The menu is accessed by clicking on the document size (xx%) 
button. The defaults are illustrated in Figure 1-23 but may be changed 
using the Set command as highlighted below. You can also magnify the 
document as needed by using the Fit commands in the pop-up menu. 

To change the zoom settings:
1. Access the Zoom Pop-up Menu and click Set. The Zoom Menu Options 

dialog box opens (Figure 1-24).

2. Change the percentages to the desired viewing level and click Set to 
close the dialog box.

3. To retrieve the defaults, click the Get Defaults button.

Note: The values you enter in the percentage boxes are automati-
cally sorted from lowest to highest when you close the window.

Figure 1-23  Zoom Pop-up Menu

Figure 1-24  Zoom Menu Options
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1.6 The Document Window

This section discusses the various components of the document win-
dow such as Preferences, Window Guides, Menu Display, and changing the 
Units of Measurement.

1.6.1 Preferences 
Dialog Box

Preferences allow you to set various functions according to your require-
ments (Figure 1-25). You activate your Preferences via the File menu.

Automatic Backup on Save.  Use this command to create a backup 
of your document every time you save your document. This creates a 
copy of your file before your latest changes are saved. The file is saved 
with the backup extension name and overwrites any previous file it 
encounters with the same name.

Note: If you use this feature be advised that it consumes disk space 
equal to the file that you are saving. 

Automatic Save - Every __ Minutes.  This is an autosave feature 
which allows you to automatically save your document in a time inter-
val you specify. The file is saved with the auto extension name. Should 
you save the file manually or use the revert to last saved version com-
mand, this file is deleted. 

Figure 1-25  Preferences Dialog Box
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Show File Translation Errors.  When selected, this item displays 
errors found when a FrameMaker file opens. It is not an error check-
ing utility.
Greek Screen Text Smaller Than ---.  When text is smaller than 
the point size specified here it displays as a gray bar. The default is 7 
points, but you may change the size as desired. 
Monitor Size.  Changes the document size accordingly. Recommend 
you maintain the Default setting unless there is a compelling reason to 
change.
Cross-Platform File Naming.  Allows filename compatibility across 
platforms. If saving to a Macintosh platform, select it from the drop 
down menu and save the document. The selections for saving files are:

• Macintosh
• Unix
• Windows

Save FrameImage with Imported Graphics.  Adds a FrameIm-
age facet to imported BMP graphics. If “on” (selected) each graphic is 
saved in its native format and in FrameImage format, which is sup-
ported by all platforms. If you open the file on another platform that 
does not support the native format, the FrameImage copy is used. 
Network File Locking.  If a file is being used by another user, if 
selected on, a warning displays that the file is already in use. Applica-
ble only to those computers and files connected to a network.
Remember Missing Font Names.  Displays the names of unavail-
able fonts that have been substituted with another font by Frame. The 
fonts reappear when the file is opened on a computer system with the 
missing fonts installed.
Enabling Asian Language Features.  Not discussed.
Product Interface.  Select FrameMaker or Structured FrameMaker 
(FrameMaker Version 7 only). If you change from one format to 
another, you must restart Frame. 

After you make your selections, click Set to close the Preferences 
dialog box, or Cancel to abort the changes.
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1.6.2 Window 
Guides

Window Guides consist of:
• Borders around imported objects, text, and graphic frames
• Markers
• Paragraph returns
• Text symbols
• Rulers
• Horizontal grids
• Vertical grids

Guides are only visible on-screen and may be turned on or off via 
the Menubar. Also, guides do not print when printing the document or 
book.

1.6.2.1 Display or 
Hide Guides

You can display or hide window guides in any individual file or an 
entire book. To hide or display borders:

1. Select the file or book you want to affect. If in book mode, select the 
file or files you want to affect.

2. If in book mode select View/Show Borders or View/Hide Borders.

3. If in an individual file select View/Borders. A check mark indicates the 
item is active.

To hide or display text symbols:
1. Select the file or book you want to affect. If in book mode, select the 

file or files you want to affect.

2. If in book mode select View/Show Text Symbols or View/Hide Text Sym-
bols.

3. If in an individual file select View/Text Symbols. A check mark indicates 
the item is active.

To hide or display rulers:
1. Select the file or book you want to affect. If in book mode, select the 

file or files you want to affect.

2. If in book mode select View/Show Rulers or View/Hide Rulers.

3. If in an individual file select View/Rulers. A check mark indicates the 
item is active.

To hide or display gridlines:
1. Select the file or book you want to affect. If in book mode, select the 

file or files you want to affect.

2. If in book mode select View/Show Grid Lines or View/Hide Grid Lines.

3. If in an individual file select View/Grid Lines. A check mark indicates 
the item is active.
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1.6.3 Menu 
Displays

You can change and customize the Menubar as required to suit your 
needs. To provide an abbreviated menu selection on the Menubar 
select:

View/Menus/Quick or Complete

To customize the menu is beyond the scope of this training and is 
not discussed.

1.6.4 Changing 
Units of Measure

Units of Measure are used throughout technical writing for various docu-
ments. (A listing of these units are on the next page.)

Frame allows you to change these units in either a single document 
or an entire book by doing the following:

1. Make active the book window or individual file(s) you want to affect.

2. Choose View/Options to open the View Options dialog box as shown 
in Figure 1-26.

3. Make the appropriate changes and click Set to close the dialog box.

Figure 1-26  View Options Dialog Box
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Display Units.  The following options are available:

Frame automatically converts the entry to the preset unit.

1.6.5 Go to Page 
Dialog Box

You can rapidly move to a specific page using the Go to Page dialog box 
(Figure 1-27). 

1. To open the dialog box do one of the following:
– From the View menu select: Go to Page
– Press CTRL+G
– Click on the page status bar.

2. The Go to Page dialog box opens.

3. Make an appropriate selection, and enter a page or line number. 
Click Go. 

4. Click Cancel to abort the operation.

cm to specify centimeters

mm to specify millimeters

“ or in to specify inches

pc, pi, or pica to specify picas

pt or point to specify points

Q to specify Q units (font size and line spacing only)

dd to specify didots

cc or cicero to specify ciceros

Figure 1-27  Go to Page Dialog Box
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1.6.6 Shortcut 
Icons

On the right side of the document window there are four icons as illus-
trated in Figure 1-28. These icons open other dialog boxes as shown in 
Figure 1-29 through Figure 1-32. To open any of these items simply 
click on the appropriate icon.

Note: By default there are only three (3) font tags in the Font Cata-
log. You can delete any or all of these font tags with the excep-
tion of the Default Font tag. This is the one tag you cannot 
delete.

Figure 1-28  Shortcut Icons

Figure 1-29  Paragraph Catalog

Figure 1-30  Font Catalog
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Note: The Equation Palette is very complex and not discussed in this 
training. 

1.6.7 Scroll Bar The scroll bar allows you to move from page to page or left and right 
through the document as desired.

Figure 1-31  Tools Palette

Figure 1-32  Equation Palette



1–30 Section 1.7 Review Questions

Lesson 1
The FrameMaker Interface

FrameMaker Basic Training
Review Questions

1.7 Review Questions

1.  What feature provides shortcuts to common commands?
a.  Menubar
b.  Edit bar
c.  QuickAccess bar
d.  None of the above

2.  The Formatting bar overrides current paragraph settings.
a.  True
b.  False

3.  The File command is part of the:
a.  Menubar
b.  QuickAccess bar
c.  Formatting bar
d.  All the above

4.  You cut, copy, and paste using what menu?
a.  File
b.  Edit
c.  Format
d.  Special

5.  You delete pages using what menu?
a.  Edit
b.  Format
c.  Graphics
d.  None of the above

6.  The QuickAccess bar contains ___ distinct functions.
a.  1
b.  2
c.  3
d.  4

7.  To increase or decrease the text view, you use the:
a.  Zoom commands
b.  View menu
c.  Format menu
d.  All the above
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If your job is technical writing or desktop publishing you understand 
the importance of consistency. Your data may be correct but if the 
delivery looks like garbage your document is considered trash. To 
maintain a professional image you must be consistent in style and 
delivery.

To help maintain this consistency, FrameMaker uses a concept 
known as tags in a document. There are two types of tags you need to 
be concerned with: Character and Paragraph. 

FrameMaker includes two designers to create these tags. These are 
the:

• Character (font) designer
• Paragraph designer

The Character Designer creates character (font) attributes for text. The 
Paragraph Designer creates paragraph tags and applies formatting 
attributes to that paragraph. 

A third designer, known as the Table Designer, creates and formats 
new tables, each with their own set of attributes. It also applies 
changes to existing tables. Since this designer is for tables I shall dis-
cuss it in the Tables lesson. However you must know how the Charac-
ter and Paragraph designers work in order to take full advantage of 
the Table designer. Thus in this lesson we are going to concentrate on 
the Character and Paragraph designer, how they work, and how to use 
them. 

Objectives:  
At the end of this lesson the student shall be able to:

1. State the function of the Character and Paragraph Designers.

2. Explain how the Character Designer functions.

3. Explain how to create and set attributes to character tags.

4. State the function of the Paragraph Designer.

5. Explain how the Paragraph Designer functions.

6. Explain how to create and set attributes to a paragraph tag.
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3.1 Lesson Preparation 

If not already done, start FrameMaker. 
1. To open a new document do one of the following:

– from the QuickAccess bar click the New Document icon 
– from the Menubar select File/New/Document
– press CTRL+N

2. The New Document dialog box opens. 

3. Click Portrait. 

4. A new document opens. 

5. Set your Preferences if necessary.

6. Ensure text and border features are turned on.

Just a tip: When working with, or preparing to work with, a new 
document, add some working space, i.e., empty paragraph tags. This 
allows you to insert elements such as graphics and additional text 
without searching for an empty paragraph tag to attach such items to. 

To insert an empty paragraph tag, simply hit the Return key a few 
times (Figure 3-1).

3.1.1 Accessing the 
Designers

To open the designers you can use the Menubar or click one of the 
shortcut icons (Figure 3-2) located on the right side of the screen. 

Figure 3-1   Empty Paragraph Tags

Figure 3-2   Shortcut Icons



FrameMaker Basic Training
Character/Paragraph Tag Commonalities

Section 3.2 Character/Paragraph Tag Commonalities 3–3

Lesson 3
Document Designers

3.2 Character/Paragraph Tag Commonalities

Since there are commonalities between a Paragraph and a Character 
tag I will discuss those here. Individual characteristics are discussed 
in their own respective section.

Note: In this lesson the terms font and character are used inter-
changeably. Unless specified differently, these two terms iden-
tify the same component and have the same meaning. 

3.2.1 Case 
Sensitivity

Almost everything in FrameMaker must be named (Section 3.2.6) and 
names are CASE SENSITIVE. This includes Paragraph and Character 
tags, tables, text flows, variables, and so forth. 

Example: body_1 and Body_1 may apply the same attributes to a 
paragraph but to Frame these are two entirely different paragraph 
tags. Mixing similar named tags in a document will, not may, will 
cause trouble later down the line, especially if the document is large 
and complex.

3.2.2 How 
Character Tags 
Work

Character tags allow you to apply specific attributes to a letter, word, 
or selection of text. An example of applying a specific character tag is 
displayed in this sentence. This sentence is normal text but the pre-
ceding is Arial italic. It is bold, italic, San Serif, and slightly larger 
than the rest of the text. In this lesson I discuss how to create these 
attributes and apply them as needed.

3.2.3 How 
Paragraph Tags 
Work

Paragraphs are the building blocks of a document. The number and 
type of paragraphs you have depends upon the document you are cre-
ating. Some paragraphs, like this one, are left aligned to the margin. 
Others may be indented, such as the paragraph following this one. Of 
course these are only two simple examples of paragraph styles. 

When you develop a paragraph, using the Paragraph designer, you 
establish specific attributes for that paragraph, including the type of 
paragraph that follows the current one. Such as: the introduction 
paragraph to a section (in this book) is named Normal_first_para. The 
follow-on paragraphs (the paragraphs following the introduction para-
graph) are named Normal. 

Individual tag names allow you to control the attributes of each tag. 
It also allows you to change the attribute of a single tag without affect-
ing the remaining tags of the same name. When you modify one tag 
without applying the changes to all the other tags of the same name, 
you create an Override for that one instance (paragraph tag). 
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FrameMaker, like any word processor allows you to add, delete, and 
edit text. You can copy, cut, and move text and graphics to various 
locations within the current document or to another Frame document. 

There is no automatic capitalization, word correction, or highlight 
and move text with the mouse command. Still Frame offers powerful 
features that one would expect in a technical documentation program.

The preferred method of formatting text is with paragraph tags, 
however you can format text “on-the-fly”. This is generally a one-of-a-
kind document which is usually not reused. We will discuss this for-
matting concept later in this lesson.

Part of Frame’s power comes from a concept known as Text Flows. As 
you type text fills the page, and when you reach the bottom it flows 
onto another page. For all word processing programs this is an auto-
matic function, and Frame has the same capability. 

There is a difference in Frame however, as Frame allows you to con-
trol the text flow. In simple terms it means you can start typing on page 
one, skip page two, and continue typing on page three. 

Newspaper columns operate the same way, that is when you reach 
the end of a column it may direct you to another page, to continue the 
article. 

The normal tag for the default text flow is known as Flow A. How-
ever, you can create other flows depending upon your requirements 
and the layout of your document. 

Flows are an integral part of word processing but before we get into 
text flows, and how they influence the document, let us explore the 
word processing elements available in Frame. There are numerous 
components in Frame’s word processing ability, most of which we will 
cover in this lesson. Hence we shall begin with Special Characters.

Objectives:  
At the end of this lesson the student shall be able to:

1. Understand how to apply and use special characters.

2. Understand how to search, find, and replace text.

3. Understand how to search, find, and replace special characters, markers, and character formats.

4. Understand how to spell check a document.

5. Understand the function of the four Frame dictionaries and how to manage them.

6. Understand how to apply automatic corrections, manage hyphenation, and use the Thesaurus.
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4.1 Special Characters

Bullets, slashes, Dingbats, dashes, and other symbols are considered 
special characters. Some special characters like the +, -, /,[ ], and so forth 
are accessible from the keyboard, others are dependent upon the fonts 
you have installed on your computer. Frame allows you to take advan-
tage of these fonts but does not create them. Some special characters 
you may use consistently, others occasionally, and still others, not at 
all. 

Note: The FrameMaker installation disk contains a directory of 
online manuals. These manuals are also copied to your hard 
drive when you install the program. 

These manuals are in PDF format and one is called the 
FrameMaker Character Sets. It is highly recommended that you 
print out the appropriate version of this manual, as it gives 
you the complete symbol set available to FrameMaker.

Special characters are created by using a combination of keys on 
the keyboard. Example, to insert an en dash (–) use the keys:

CTRL+Q SHIFT + P

That is press and hold the Control key, and press the q key. 
Release. Next press and hold the Shift key while pressing the p key. 
The en dash (–) appears.

Other key combinations create other symbols or characters. The 
Quick Reference Card that comes with Frame has a section for special 
characters which are used most often. However, the Character Sets 
manual contains all the special characters available and the key com-
binations necessary to insert them.

Note: The Quick Reference Card is a treasure trove of information. 
My advice, make it your best friend.
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4.1.1 ANSI Codes What is an ANSI code? Basically speaking they are a collection of spe-
cial characters which was approved and adopted by the American 
National Standards Institute (ANSI). This organization is considered 
the subject matter expert and sets the standards used in the comput-
ing field. 

Note: If you require more information on ANSI, perform an internet 
search on the subject.

ANSI codes are created by holding down the ALT key and typing in 
the appropriate number on the numeric keypad to obtain the character 
you desire. The Character Sets manual contains the codes available for 
the ANSI set.

When using an ANSI code you must include the leading zero in the 
code. A good example is the questiondown character (¿). This character 
was retrieved via the ANSI code sequence. To use ANSI codes:

1. Ensure the numeric keypad is active (Num Lock is on).

2. Press and hold the ALT key.

3. On the numeric keypad, type in the appropriate code, including any 
leading zeros.

4. Release the ALT key.

Ok, so how do you make the questiondown character? ALT+0191
Sometimes you may find ANSI codes faster than keyboard com-

mands. In addition you may find that keyboard commands do not give 
you the results you want where as ANSI codes will, and vice versa. The 
point is, be familiar with both methods of inserting special characters. 

ANSI codes are found in the FrameMaker Character Sets manual.

4.1.2 Dialog Boxes Frame uses many dialog boxes for a variety of purposes. Some you 
have to type in a sequence of characters in order to display them prop-
erly within the document. Examples of these are bullets, special 
hyphens, nonbreaking spaces, and so forth. 

The Numbering tab of the Paragraph Designer is a good example of 
a dialog box requiring a series of special characters. These special 
characters must be proceeded by a backslash (\) in order for the spe-
cial character to display properly. 

Open the Paragraph Designer and select the Numbering tab (Fig-
ure 4-1). Notice the Building Blocks area and how a backslash pro-
ceeds the letter. Observe the first character: \b. This code tells Frame 
to insert a bullet for this paragraph tag. The second character (\t) 
inserts a tab, and so forth. And yes, you can use the codes together.
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Frame does not automatically insert special formats for you, it is 
your job to learn the sequence of characters and the special characters 
they represent. 

Appendix E contains a listing of building blocks you can use in your 
documentation.

Figure 4-1   Numbering Tab – Paragraph Designer Building Blocks
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Graphics are an important part of technical documentation. One 
graphic, well organized, can convey more information than two or 
three pages of text covering the same topic.

Frame has numerous and sophisticated drawing tools which you 
can use to create lines, rectangles, polygons, and so forth. The problem 
with this approach is that the graphic cannot be used over again and is 
unique to the particular document it was created in. Also, should infor-
mation on the graphic change, it cannot be easily updated. Nor can it 
be easily manipulated. Hence, another solution is required.

Many technical writers are not graphic artist (including yours 
truly), consequently companies hire an illustrator to create the graphics 
necessary for the project(s). 

Illustrators use a variety of tools to create the illustrations needed 
to fill the requirements of a project. If you are working on a repair 
manual and need a parts breakdown graphic, the illustrator provides 
the graphic requested. But, it is your responsibility to provide accurate 
information to the illustrator, so that he/she may provide what you 
need. This is not to say that revisions/corrections are avoidable, but 
with proper care and planning they can be reduced.

It is not important that you know how to create a graphic, only how 
to manipulate it in Frame. This chapter covers those techniques. How-
ever, we should not overlook Frame’s own drawing tools. Thus we 
begin our discussion with the FrameMaker drawing tools.

Note: Creating a graphic is not the same as capturing a screen shot, 
which can be accomplished and manipulated by the technical 
writer using the correct software.

Objectives:  
At the end of this lesson the student shall be able to:

1. Understand FrameMaker drawing tools and properties.

2. Understand the difference between an anchored and unanchored graphic frame.

3. Understand graphic frame properties.

4. Understand the concepts of importing graphics and text files.

5. Understand how to import a graphic.

6. Understand how to import a text file.
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8.1 FrameMaker Drawing Tools

There may be a time when you need to use Frames drawing tools for 
some simple standalone document that will never change. When work-
ing on a project drawing packages like Photoshop, Illustrator, Free-
hand, Fireworks, AutoCad, and many others, are far superior and 
provide the illustrator with the instruments necessary to complete the 
undertaking. Nevertheless don’t underestimate the power of Frames 
own drawing tools. In the right hands they can create some powerful 
images. 

We are not going to dwell too long on FrameMaker’s drawing tools 
since in a majority of cases graphics are imported and not drawn in a 
document. However, if you wish to fully understand how these tools 
work, the on-line help has a complete section on the subject.

Snap and Gravity
Frame employs two functions used in graphics: snap and gravity. 

Snap allows an object to be attracted to an invisible point on the screen 
where gravity manipulates the pointer so that an object is attracted to 
it. When both are used together gravity takes precedence over snap. 

Gravity is more applicable to the FrameMaker drawing tools and 
has a direct bearing on objects drawn using these tools. More so than 
snap. 

Snap is more useful in creating text and graphic frames and posi-
tioning imported graphics.

In this lesson we will concentrate on the snap function as gravity 
has no direct bearing for our purposes. 
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8.1.1 Graphics 
Menubar

The Graphics menu (Figure 8-1) provides the commands necessary to 
modify any graphic created using the FrameMaker drawing tools. 
Many of the graphic editing commands may also be accessed using the 
QuickAccess bar functions, most notably the Graphics bar and Graph-
ics Editing bar. 

Figure 8-1  The Graphics Menu
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8.1.2 Tools Palette The FrameMaker Tools Palette contains all the drawing tools avail-
able in Frame. 

1. To access the Tools Palette do one of the following:
– From the Menubar select: Graphics/Tools
– Click on the Tools Palette shortcut icon (Figure 8-2) on the right side 

of the screen.

2. The tools palette opens (Figure 8-3).

Figure 8-2  Shortcut Icons

Figure 8-3  Tools Palette



9–1

Lesson 9.0  Tables

Tables are used everywhere in technical documentation. They orga-
nize and present information in an attractive, easy-to-use format.

Like the Character and Paragraph Designer you create and store 
tables within a Table Catalog for use over and over again.

In this lesson we are going to study various types of tables and how 
to create and manipulate them.

Objectives:  
At the end of this lesson the student shall be able to:

1. State the function, and demonstrate the use of, the Table Designer and Table Catalog.

2. Modify an existing table.

3. Create a new table.

4. Edit a table.

5. Customize a table.

6. Add text, graphics, and special formatting to a table.
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9.1 Table Basics

A FrameMaker document comes standard with two default tables, 
aptly named Format A and Format B. The default settings for these tables 
generally are:

Note: It is possible that the default settings may change from com-
puter to computer.

• 5 columns
• 8 rows
• 1 heading row

Format A is defaulted as a left aligned and Format B is defaulted as 
centered on the page. An example of each of the default tables is shown 
in Figure 9-1 and Figure 9-2.

In addition to adding text to table cells you can also:
• Add graphics to a cell
• Mix graphics and text in same cell
• Rotate cells
• Simulate spreadsheet columns
• Custom shade specific cells
• Add custom ruling to table rows, columns, and cells

Figure 9-1  Default Table: Format A – Left Aligned



FrameMaker Basic Training
Table Basics

Section 9.1 Table Basics 9–3

Lesson 9
Tables

Tables and their properties are controlled by the Table Designer. Like 
the Character and Paragraph Designer, changing the formats in the 
Table Designer changes the appearance of the table that uses the 
assigned format.

FrameMaker tables have three default properties assigned to them 
[these properties cannot be deleted but they can be modified]. These 
properties are:

• Number of body, heading, and footing rows
• Number of columns
• Paragraph formats

The paragraph formats control the:
• Title
• Heading 
• Footer
• Body cells

Tables can be complex or simple depending upon the needs of the 
document. 

Figure 9-2  Default Table: Format B – Centered on Page
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9.1.1 Labeling a 
Table

You label a table by creating a paragraph tag for it. This tag sets spe-
cific attributes and permits you to number your table. 

Note: While numbering a table is not required, to establish a List of 
Tables (and most documents require it) you need to set-up a 
specific title and numbering scheme. 

When a table extends beyond a single page you apply a special vari-
able, generally the Table Continuation variable, to carry the title over to 
additional pages. You apply the Table Continuation variable at the 
end of the title as illustrated in Figure 9-3. 

Figure 9-3  Table Continuation Symbol
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9.1.2 QuickAccess 
Table Editing

If you constantly work with tables you may find the QuickAccess Table 
bar an asset (Figure 9-4). This bar contains shortcuts you can use to 
make working with tables easier. 

Figure 9-4  QuickAccess Table Editing Bar
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Books are everywhere. From novels to technical manuals to user 
guides. They exist in every conceivable form, and cover any subject, 
imaginable. 

When you create a related series of documents in FrameMaker you 
are on the path to composing a book. Hence a FrameMaker book is 
nothing more than a collection of individual files tied together by a 
special file containing the extension – book. 

Books normally contain chapters, table of contents, list of figures, 
list of tables, appendices, an index and so forth. Books also control 
page and chapter numbering across the file spectrum. 

Books allow you to print an entire set of files, or selected files, 
either to a printer or to a file. When printing a book to a file you gener-
ally employ the steps to convert it into a Portable Document Format (PDF) 
file, which may then be distributed as required.

Since professionalism depends upon consistency, when you work 
with books your job is to ensure each individual file is consistent with 
every other file (chapter) associated with the book. Fortunately Frame 
has several options which allows you to simplify this process. One of 
these options is the Import Formats command. 

Importing document formats is only a tool used to create consistency 
among documents and books. The real power of consistency lies in the 
usage of Style Guides.

Objectives:  
At the end of this lesson the student shall be able to:

1. Explain the purpose of a book file.

2. Add, delete, and move book files.

3. Create a Numbering strategy for a book.

4. Create a Table of Contents, List of Figures, and List of Tables.

5. Print the contents of a document or book to paper or file.

6. Create a PDF.
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10.1 The Style Guide

Consistency is normally regulated by some type of Style Guide, be it from 
the company or some other source. 

Note: This is not a lesson on style guides, but since consistency is 
critical to documentation, an understanding of this topic is 
useful. For additional information, I recommend a web search 
of the subject. There you will find numerous sources which you 
may find helpful.

The style guide dictates the rules and regulations concerning every 
aspect of document creation. From simple memos to complex manuals, 
the style guide directs it all.

If you work for a company you should be familiar with their style 
guide, especially their method of document creation and control. It is 
your responsibility to learn and apply the style guide to any document 
you create.

What if you or your company does not have a style guide? In this 
case the Chicago Manual of Style is the definitive document to consult. It 
is considered the essential reference of anything written. It provides 
instructions and guidelines on almost everything from simple formats 
to editorials to complex documents. While the Chicago Manual of Style 
is considered the father of style, it is by no means the only one.

There are style guides for virtually every type of documentation in 
existence. Companies often develop their own style which mandate a 
format reflecting the personality of that company. 

Once the style is established, you utilize Frame’s Import feature to 
maintain consistency among all related documents.
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10.2 Importing Formats

Once you establish the first document of the project you import the for-
mats of the source document into other documents. Importing formats 
can be accomplished using a pre-existing template or a pre-existing 
file.

Note: Importing formats can also be applied at the book level. How-
ever, importing formats at the book level is slightly different 
than importing formats between documents. Later in this les-
son we will cover the procedure for importing formats at the 
book level.

When you import formats from one document into a current docu-
ment you do not replace the formats of the current document. What 
transpires is you merge the two formats together.

Example: If I have two documents, Doc_A and Doc_B, and the format 
in Doc_A changes, I can update Doc_B by importing the changes from 
Doc_A. When I import the changes into Doc_B, identical elements are 
overwritten but dissimilar elements are added to Doc_B. In short, any 
unlike elements are merged into Doc_B from Doc_A.

FrameMaker provides a wide variety of format imports as illus-
trated in Figure 10-1. When you update from a source document, such 
as Doc_A, you also have the option of removing any manual overrides 
and page breaks. However, you should use caution with these func-
tions as the results may not be what you want and there is no undo to 
this feature.

To import formats from a source document into the current docu-
ment:

1. From the Menubar select: File/Import/Formats

2. The Import Formats dialog box opens (Figure 10-1).

3. From the drop down list, select the document you want to import from.

4. Select the style of format you want to import. 
– Not all formats have to be selected. Example: To import only Para-

graph styles, deselect all but Paragraph Formats.

5. If desired select to remove all manual page breaks and overrides 
(Figure 10-2).

6. Click Import to bring the updates/formats into the current document.
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Figure 10-1  Import Formats Dialog Window

Figure 10-2  Override/Page Break Removal
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10.3 File Structure 

Books are made up of individual files, therefore it is important that all 
files associated with the book be in the same directory. If you have any 
referenced graphics they should be in a sub-directory of the document 
directory, as illustrated below.

In order to make a book format the way you want, the way you add 
and arrange files is critical. Not all files are labeled Chapter 1, Chap-
ter 2, Chapter 3, and so forth. Most files have individual names which 
are arranged alphabetically by Windows. This is not an issue in 
Frame, but file arrangement in a book window (Figure 10-4) is impor-
tant, if you want the book to print correctly. 

10.3.1 File Types There are two types of files you add to a book: regular documents and gen-
erated files.

Regular documents are those you create, Chapter 1, Chapter 2, 
Introduction and so forth. Generated files consist of documents created 
by FrameMaker, such as:

• Table of Contents
• List of Figures
• List of Tables
• Index

You add generated files at the appropriate time in the book creation 
process which is generally after you have added all the files to the 
book. A process we will discuss later in this lesson. The first step, how-
ever, is to create the actual Book File.
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Appendix E  Building Blocks

FrameMaker employs a set of building blocks which enable you to cre-
ate a variety of documents. This appendix list the building blocks 
available to each Frame document. 

These listings are broken down into the following formats:
• General – List all building blocks available in alphabetical order.
• Date and Time – List all building blocks associated with time and 

date.
• Special Characters – List all building blocks/characters that you can 

search for using the Find dialog box.
• Autonumber – List all building blocks associated with autonumber-

ing.
• Cross-Reference – List all building blocks associated with cross-ref-

erences.
• Index Markers – List all building blocks/characters associated with 

creating indexes.
• Variables – List all building blocks associated with variables.
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Building Block – General Listing 

: Separates levels in the index marker

; Separates entries in the index marker

[ ] Indicates sort order for an index entry

\b Bullet

\t Tab

< =0> Resets value to zero

< > Keeps value of first counter

<$alphabetics> Sort order for alphetical entries

<$ampm> Morning or evening time designation (Lowercase)

<$AMPM> Morning or evening time designation (Uppercase)

<$attribute[attrname]> Value of specified attribute for the linked element

<$autorange> Sets page ranges 

<$chapnum> Sets chapter number

<$condtag[condtag]> Specified condition tag

<$creationtime> Displays document creation time

<$currentpagenum> Displays current page number

<$currenttime> Displays current time of document (updated when saved/printed)

<$dayname> Displays current day of the week in long form (Monday)

<$daynum> Displays current day number (1 – 7)

<$daynum01> Displays current day number preceded with leading zero (0)

<$defaulttitle> Displays text of first document heading

<$elempagenum[elemtag]> Displays page number on which a specified element occurs

<$elempagenum> Displays page number of the linked element

<$elemparanum[elemtag]> Displays element’s autonumber, including any attached text

<$elemparanum> Displays linked element’s autonumber 

<$elemparanumonly[elemtag]> Element’s autonumber, excluding text

<$elemparanumonly> Displays autonumber of linked element, excluding text

<$elemtag[elemtag]> Displays the name a specified element

<$elemtag> Displays the name of the linked element
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<$elemtext[elemtag]> Displays the text of the first element on the page matching the tag

<$elemtext> Displays text of first linked element on page including autonumber

<$elemtextonly[elemtag]> Displays text of first element on page matching specified tag, 
excludes autonumber

<$elemtextonly> Displays text of first linked element on page, excludes autonumber

<$endrange> End of page range 

<$filename> Displays name of file

<$fullfilename> Displays path and name of file

<$highchoice[attrname]> Displays highest value of the specified attribute on the page

<$hour> Displays hour (single digit)

<$hour01> Displays hour with leading zero (0)

<$hour24> Displays hours in military format (0–24 hours)

<$lastpagenum> Displays last page number of the document

<$lowchoice[attrname]> Displays lowest value of the specified attribute on the page

<$marker1> Header/Footer marker text 

<$marker2> Header/Footer marker text

<$minute> Displays minutes

<$minute00> Displays minutes with leading zero (0)

<$modificationtime> Displays time document was modified (upated when saved or 
printed)

<$monthname> Displays current name of month as text (January)

<$monthnum> Displays current month as a number

<$monthnum01> Displays current month as a number with leading zero (0)

<$nextsubdoc> Displays URL of the next document

<$nopage> Suppresses page number

<$numerics> Sort order for numeric entries

<$ObjectId> Object id – Displays numeric identifier assigned to linked object

<$ObjectType> Displays numeric identifier denoting type of link

<$pagenum> Displays page number of a linked object

Building Block – General Listing  (Continued)
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<$paranum[paratag]> Displays autonumber of first matching paragraph tag on page, 
including associated text

<$paranum> Displays autonumber of a linked paragraph, including text

<$paranumonly[paratag]> Displays autonumber of specified paratag, excludes text

<$paratag[paratag]> Displays name of fist matching paragraph tag on page

<$paratext[+, paratag]> Displays text of last matching paragraph tag on page

<$paratext[paratag1, paratag2, 
partag3]>

Displays text of first paragraph matching specified tag

<$paratext> Displays text from the source paragraph

<$parentdoc> Displays URL of first document

<$prevsubdoc> Displays URL of previous document

<$relfilename> Displays relative path to a linked file

<$second> Displays seconds

<$second00> Displays seconds with leading zero (0)

<$shortdayname> Displays name of the current day in abbreviated form (Mon)

<$shortmonthname> Displays name of current month in abbreviated form (Jan)

<$shortyear> Displays current year in abbreviated form (04)

<$singlepage> Designates single page number after <$nopage>

<$startrange> Set beginning of page range

<$symbols> Sort order for symbolic entries

<$tablesheetcount> Displays total sheet count for current table

<$tablesheetnum> Displays number of current sheet in present table

<$variable[varname]> Displays text of specified variable

<$volnum> Volume number

<$year> Displays current year in long format (2004)

<a+> Alphabetical numbering (lowercase), increments by 1

<A+> Alphabetical numbering (uppercase), increments by 1

<a=1> Alphabetical numbering (lowercase), sets value to 1

<A=1> Alphabetical numbering (uppercase), sets value to 1

<a> Alphabetical numbering (lowercase), value unchanged

Building Block – General Listing  (Continued)
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<A> Alphabetical numbering (uppercase), value unchanged

<char_tag> Applies a specified character tag to text within a building block 
definition

<Default Para Font> Removes any character formatting and returns text to the specified 
paragraph font

<n+> Numeric numbering, increments by 1

<n=1> Numeric numbering, sets value to 1

<n> Numeric numbering, value unchanged

<r+> Roman numeral numbering (lowercase), increments by 1

<R+> Roman numeral numbering (uppercase), increments by 1

<r=1> Roman numeral numbering (lowercase), sets value to 1

<R=1> Roman numeral numbering (uppercase), sets value to 1

<r> Roman numeral numbering (lowercase), value unchanged

<R> Roman numeral numbering (uppercase), value unchanged

Building Block – General Listing  (Continued)
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Date and Time Building Blocks

<$ampm> Morning or evening time designation (Lowercase)

<$AMPM> Morning or evening time designation (Uppercase)

<$dayname> Displays current day of the week in long form (Monday)

<$daynum> Displays current day number (1 – 7)

<$daynum01> Displays current day number preceded with leading zero (0)

<$hour> Displays hour (single digit)

<$hour01> Displays hour with leading zero (0)

<$hour24> Displays hours in military format (0–24 hours)

<$minute> Displays minutes

<$minute00> Displays minutes with leading zero (0)

<$monthname> Displays current name of month as text (January)

<$monthnum> Displays current month as a number

<$monthnum01> Displays current month as a number with leading zero (0)

<$second> Displays seconds

<$second00> Displays seconds with leading zero (0)

<$shortdayname> Displays name of the current day in abbreviated form (Mon)

<$shortmonthname> Displays name of current month in abbreviated form (Jan)

<$shortyear> Displays current year in abbreviated form (04)

<$year> Displays current year in long format (2004)
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Special Characters (Search Parameters)

Discretionary hyphen \- (hyphen)

Em space \M or \sm

En space \N or \sn

End-of-flow symbol \f

End-of-paragraph \p (lowercase)

End-of-word \>

Forced Return \r

Nonbreaking hyphen \+

Nonbreaking space \ (space)

Numeric space \# or \s#

Start-of-paragraph \P (uppercase)

Start-of-word \<

Suppress hyphenation \_ (underscore_

Tab \t

Thin space \i or \st
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Autonumber Building Blocks

\b Bullet

\t Tab

< =0> Resets value to zero

< > Keeps value of first counter

<$chapnum> Sets chapter number

<$volnum> Volume number

<a+> Alphabetical numbering (lowercase), increments by 1

<A+> Alphabetical numbering (uppercase), increments by 1

<a=1> Alphabetical numbering (lowercase), sets value to 1

<A=1> Alphabetical numbering (uppercase), sets value to 1

<a> Alphabetical numbering (lowercase), value unchanged

<A> Alphabetical numbering (uppercase), value unchanged

<char_tag> Applies a specified character tag to text within a building block 
definition

<Default Para Font> Removes any character formatting and returns text to the specified 
paragraph font

<n+> Numeric numbering, increments by 1

<n=1> Numeric numbering, sets value to 1

<n> Numeric numbering, value unchanged

<r+> Roman numeral numbering (lowercase), increments by 1

<R+> Roman numeral numbering (uppercase), increments by 1

<r=1> Roman numeral numbering (lowercase), sets value to 1

<R=1> Roman numeral numbering (uppercase), sets value to 1

<r> Roman numeral numbering (lowercase), value unchanged

<R> Roman numeral numbering (uppercase), value unchanged
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Cross-Reference Building Blocks

<$attribute[attrname]> Value of specified attribute for the linked element

<$chapnum> Sets chapter number

<$elempagenum[elemtag]> Displays page number on which a specified element occurs

<$elempagenum> Displays page number of the linked element

<$elemparanum[elemtag]> Displays element’s autonumber, including any attached text

<$elemparanum> Displays linked element’s autonumber 

<$elemparanumonly[elemtag]> Element’s autonumber, excluding text

<$elemparanumonly> Displays autonumber of linked element, excluding text

<$elemtag[elemtag]> Displays the name a specified element

<$elemtag> Displays the name of the linked element

<$elemtext[elemtag]> Displays the text of the first element on the page matching the tag

<$elemtext> Displays text of first linked element on page including autonumber

<$elemtextonly[elemtag]> Displays text of first element on page matching specified tag, 
excludes autonumber

<$elemtextonly> Displays text of first linked element on page, excludes autonumber

<$filename> Displays name of file

<$fullfilename> Displays path and name of file

<$pagenum> Displays page number of a linked object

<$paranum[paratag]> Displays autonumber of first matching paragraph tag on page, 
including associated text

<$paranum> Displays autonumber of a linked paragraph, including text

<$paranumonly[paratag]> Displays autonumber of specified paratag, excludes text

<$paratag[paratag]> Displays name of fist matching paragraph tag on page

<$paratext[+, paratag]> Displays text of last matching paragraph tag on page

<$paratext[paratag1, paratag2, 
partag3]>

Displays text of first paragraph matching specified tag

<$paratext> Displays text from the source paragraph

<$volnum> Volume number

<char_tag> Applies a specified character tag to text within a building block 
definition

<Default Para Font> Removes any character formatting and returns text to the specified 
paragraph font
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Index Markers

: Separates levels in the index marker

; Separates entries in the index marker

[ ] Indicates sort order for an index entry

<$endrange> End of page range 

<$nopage> Suppresses page number

<$singlepage> Designates single page number after <$nopage>

<$startrange> Set beginning of page range

<char_tag> Applies a specified character tag to text within a 
building block definition

<Default Para Font> Removes any character formatting and returns 
text to the specified paragraph font
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Variable Building Blocks 

<$ampm> Morning or evening time designation (Lowercase)

<$AMPM> Morning or evening time designation (Uppercase)

<$attribute[attrname]> Value of specified attribute for the linked element

<$chapnum> Sets chapter number

<$condtag[condtag]> Specified condition tag

<$creationtime> Displays document creation time

<$currenttime> Displays current time of document (updated when saved/printed)

<$dayname> Displays current day of the week in long form (Monday)

<$daynum> Displays current day number (1 – 7)

<$daynum01> Displays current day number preceded with leading zero (0)

<$elempagenum[elemtag]> Displays page number on which a specified element occurs

<$elempagenum> Displays page number of the linked element

<$elemparanum[elemtag]> Displays element’s autonumber, including any attached text

<$elemparanum> Displays linked element’s autonumber 

<$elemparanumonly[elemtag]> Element’s autonumber, excluding text

<$elemparanumonly> Displays autonumber of linked element, excluding text

<$elemtag[elemtag]> Displays the name a specified element

<$elemtag> Displays the name of the linked element

<$elemtext[elemtag]> Displays the text of the first element on the page matching the tag

<$elemtext> Displays text of first linked element on page including autonumber

<$elemtextonly[elemtag]> Displays text of first element on page matching specified tag, 
excludes autonumber

<$elemtextonly> Displays text of first linked element on page, excludes autonumber

<$filename> Displays name of file

<$fullfilename> Displays path and name of file

<$highchoice[attrname]> Displays highest value of the specified attribute on the page

<$hour> Displays hour (single digit)

<$hour01> Displays hour with leading zero (0)

<$hour24> Displays hours in military format (0–24 hours)
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<$lastpagenum> Displays last page number of the document

<$lowchoice[attrname]> Displays lowest value of the specified attribute on the page

<$marker1> Header/Footer marker text 

<$marker2> Header/Footer marker text

<$minute> Displays minutes

<$minute00> Displays minutes with leading zero (0)

<$modificationtime> Displays time document was modified (upated when saved or 
printed)

<$monthname> Displays current name of month as text (January)

<$monthnum> Displays current month as a number

<$monthnum01> Displays current month as a number with leading zero (0)

<$pagenum> Displays page number of a linked object

<$paranum[paratag]> Displays autonumber of first matching paragraph tag on page, 
including associated text

<$paranum> Displays autonumber of a linked paragraph, including text

<$paranumonly[paratag]> Displays autonumber of specified paratag, excludes text

<$paratag[paratag]> Displays name of fist matching paragraph tag on page

<$paratext[+, paratag]> Displays text of last matching paragraph tag on page

<$paratext[paratag1, paratag2, 
partag3]>

Displays text of first paragraph matching specified tag

<$paratext> Displays text from the source paragraph

<$second> Displays seconds

<$second00> Displays seconds with leading zero (0)

<$shortdayname> Displays name of the current day in abbreviated form (Mon)

<$shortmonthname> Displays name of current month in abbreviated form (Jan)

<$shortyear> Displays current year in abbreviated form (04)

<$tablesheetcount> Displays total sheet count for current table

<$tablesheetnum> Displays number of current sheet in present table

<$volnum> Volume number

<$year> Displays current year in long format (2004)

Variable Building Blocks  (Continued)
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<char_tag> Applies a specified character tag to text within a building block 
definition

<Default Para Font> Removes any character formatting and returns text to the specified 
paragraph font

Variable Building Blocks  (Continued)
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$chapnum 7-6
$chapnum building block 6-42
$volnum 7-6

A

access bars 1-16
Acrobat Distiller 10-48
Add New Text Frame dialog box 
5-19
Add Page dialog box 5-5
Advanced Tab 3-42
All Tagged 3-20
ALT Copy Text 4-9
American National Standards Insti-
tute 4-3
anchor symbol 8-17
anchored frame

copy, move, or delete 8-38
creating 8-27
resizing 8-39

Anchored Frame dialog box 8-23, 
8-24
Anchored frames 8-23
anchored graphic frame 8-16
ANSI Codes 4-3
Applying Paragraph Tags 2-16
As Is 3-18, 3-20, 3-28
Asian Language Features 1-24
asterisk 1-21, 2-15
Autoconnect option 5-17
Automatic Backup 1-23, 2-4

Automatic Hyphenation 3-43
Automatic Letter Spacing 3-44
Automatic Save 1-23, 2-4
Autonumbers 3-41

B

background graphic 2-14
backup extension 1-23
backward compatibility 2-14
balance columns 5-28
Baseline Synchronization 5-30
basic concepts 2-1
Basic Tab 3-31
Body Pages 5-2
boilerplate information 5-8
Book Error Log 10-29
book file 10-6
book numbering 10-26
book numbering scheme 10-21, 
10-30
book window 10-8
Bookmark level 10-54
books 10-1

adding files 10-8
Custom Numbering 10-23
delete files 10-13
error messages 10-29
file naming 10-11
file renaming 10-14
file structure 10-5
generated files 10-5
importing formats 10-1, 10-3, 

10-20
merging formats 10-3

Numbering Properties 10-21
Numbering Properties dialog 

box 10-23
opening 10-16
opening, closing and saving 

files 10-15
Portable Document Format 

10-1
rearrange files 10-13
regenerate 10-33
selecting files 10-12
shortcut icons 10-17
Style Guides 10-1

borders and text symbols 2-14
building blocks 3-3, 6-47
bullet list 7-14
buttons

Previous and Next 1-16

C

case sensitivity 3-3, 5-4
catalogs

Paragraph and Catalog 1-4
Change All 4-23, 4-29
Change options 4-29
Changing a Tag 2-16
Character and Paragraph Tags

deleting 3-5
Character and Paragraph tags 5-1
Character Deletion dialog box 3-6
Character Designer

other features 3-17
Character designer 3-1, 3-11, 3-13
Character Designer New Format di-

Index
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alog box 3-12
Character Sets 4-2
Character tag 3-1, 3-3
Character/Paragraph Tag Com-
monalities 3-3
Characters 4-13
Chicago Manual of Style 10-2
Collate 10-49
color

color definition 4-14
Color Definitions dialog box 

4-15
Color Libraries 4-14, 4-15
Color Pickers 4-15

Color option 8-11
column balancing 5-30
column gap 5-25
Column Layout dialog box 5-25
Columns 5-24

Balanced text flow 5-26
Base Synchronize text flow 

5-26
changing number of 5-25
Feathered text flow 5-26

COMMANDS menu 3-18
Commonly Used ANSI Codes 4-5
Commonly Used Special Charac-
ters 4-5
complex and multi-volume docu-
ments 2-1
connecting text frames 5-45
consistency 2-8, 3-1, 3-7, 3-30
Converting a Variable or Cross-
Reference 6-49
Converting Text to a Table 9-54
create a document 5-1
Create New Text Frame dialog box 
5-35
Create Variable 6-10
Creating a Cross-Reference 6-36
Creating a New Document 2-6
Creating a variable 6-9

creating new documents and books 
1-6
Cross-Platform File Naming 1-24
Cross-Platform Naming 2-4
cross-reference 6-1, 6-26

building blocks 6-34
deleting 6-51
editing 6-49
error messages 6-54
Formatting 6-32
Reference 6-27
Reference Block 6-27
Source 6-27
Source Block 6-27
specifying a format 6-29
specifying a source 6-29
updating 6-33, 6-52
Working with Building Blocks 

6-37
Cross-Reference Basics 6-26
Cross-Reference dialog box 6-27, 
6-29, 6-48
Cross-Reference Maintenance 
6-48
Cross-References 10-54
CTRL+ALT 6-32
Current Page # 6-5
Custom Blank Paper dialog box 2-7
Custom Dialog Box 2-7
Custom Master Page 5-19
Custom Numbering dialog box 
10-23
Custom Ruling and Shading dialog 
box 9-52
Customize Text Frame dialog box 
5-32
customized search 4-23

D

Dashed Line Options dialog box 
8-9
Default Font Tab 3-34

Default Font tag 3-6, 3-11
modifying 3-35

default Master page 5-15
default paragraphs 3-30
default settings 6-13
delete a Character or Paragraph tag 
3-6
delete a color 4-18
Delete a Text Page 4-10
Delete Format 3-6, 3-18
Delete Pages Dialog Box 4-10
delete text 4-10
Deleting Pages 5-7
Designers

accessing 3-2
designers 3-1
desktop publishing 3-1
dialog boxes 1-7, 4-3
Dictionaries 4-34

Automatic Correction 4-40
dct extension 4-35
Document Dictionary 4-31, 

4-33, 4-34, 4-35, 4-38, 4-39
Editing a Dictionary 4-38
Functions 4-32, 4-33
Main Dictionary 4-34
Managing Dictionaries 4-35
personal dictionary 4-35, 4-38
site dictionary 4-34, 4-35, 4-38
user dictionary 4-34

dictionary-style layout 6-16
disable a personal dictionary 4-37
Disconnected Pages

adding 5-36
Display Units 1-27
Document numbering 7-12
Document planning 3-5, 3-30
document window 1-23
double-sided document 5-2, 5-3
drawing grids 8-12
drawing properties 8-5, 8-6
duplicate frames 5-20
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E

Edit menu 1-8
Electronic publishing 10-47
EM Space 4-6
EN dash 4-2
EN Space 4-6
Explore Standard Templates 2-10, 
2-11

F

F8 key 3-7
F9 key 3-8
Feathering 5-29
figure numbering 9-38
File command 1-6
File menu 1-7

Preferences 1-23
Find drop-down box 4-20
Find/Change dialog box 4-20
Finding a Marker with Specific 
Text 4-29
Finding a Specific Marker 4-28
Finding Any Marker 4-27
Flip QuickAccess Bar option 1-16
flow tags 5-15
Font Catalog 2-5, 3-14

displaying 3-12
Font Option 4-11
Font Size Option 4-11
Font Styles 4-12
font tags 2-5
fonts

additional font sizes 4-12
format a document 5-1
Format menu 1-10, 4-11
Formatting 1-3
Formatting Bar 2-14, 2-15
Frame Interface 2-1
FrameImage 1-24

FrameMaker 2-1
FrameMaker Character Sets 4-2
FrameMaker document

new 1-4

G

Generate Acrobat Data option 
10-54
Generated Files 10-33
Generated Lists, 10-33
generating Acrobat data 10-54
global changes 3-19
Global commands 3-18, 3-20
global update command 3-19
Global Update Options 3-18
Global Update Options dialog box 
3-19
Go to Page 1-27
graphic filters 8-14
graphic frame 5-9, 8-15
graphic frame names 5-10
graphic frames 8-5, 8-7
Graphic scaling 8-45
graphics 1-16, 8-1

anchored 8-15
crop 8-19
cropped 8-27
drawing tools 8-2
editing 8-38
effects 8-37
floating 8-27
gravity 8-2
import 8-19
Import feature 8-42
imported 8-2
menu 8-3
Object Selection Tool 8-5
properties 8-17
QuickAccess bar 8-3
resizing 8-40
rotating 8-31

Runaround Properties 8-21
Scale dialog box 8-41
Smart Selection Tool 8-5
snap 8-2
Tools Palette 8-4
unanchored 8-15

Graphics bar 1-18, 8-3
graphics editing 1-16
Graphics Editing Bar 1-18, 1-19, 
8-3
Graphics menu 1-13
Greek Screen Text 1-24
Grid Line Spacing 8-13
gridlines 1-25

H

Help menu 1-15
holding pages 5-21
Hyperlinks 10-54
Hyphenation 4-41
hyphenation 3-43

I

import a document 2-15
Import by Reference 8-42
Import Text Flow by Reference di-
alog box 8-53
Import Text Flow dialog box 8-50
Importing a graphic 8-43
Importing Formats 5-1, 8-42
Importing text files 8-46
Interface 1-1

primary interface window 1-1
interface modes 1-3

L

landscape page 5-16
Lesson Preparation 3-2
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Line End option 8-10
Line End Options dialog box 8-10
Line Layout dialog box 5-30
Line Style option 8-9
Line Width Options dialog box 8-7
List of Figures 10-34, 10-43
List of Tables 10-34, 10-43

M

Main Dictionary 4-31
Manual hyphenation 3-43
margins

adjusting 5-32
asymmetrical 5-32
symmetrical 5-32

markers 6-17
creating 6-22
deleting 6-23
editing 6-19
formatting 6-19
inserting 6-18
renaming 6-24
system 6-24
working with 6-18

Master and Reference page
commonalities 5-4
naming 5-4

Master or Reference Page 5-2
Master or Reference page

renaming 5-6
Master page default view 5-14
Master Page Usage 5-53
Master Pages 5-1, 5-13

adding graphics 5-21
modifying 5-21
rotating 5-45

Master pages
limitation of 5-13

maximum page size 5-22
Menu Display 1-23, 1-26
Menubar 1-3, 1-5, 1-6

keyboard commands 1-6
Missing Font Names 1-24
Monitor Size 1-24
multi-chapter project 3-6
multiple flows 5-16
multiple tags 3-6

N

naming conventions 3-7, 3-9
naming tags 3-10
New Document icon 2-6
New Format 3-18
new paragraph style 5-12
Nonbreaking Space 4-6
Not Found error 4-26
numbering 7-1

Autonumber List 7-5
autonumbering format 7-7
book numbering 7-12
Counter 7-7
multiple styles 7-10
numbering tag 7-6
Page Numbering 7-12
paragraph numbers 7-16
Series Label 7-7
Tab 7-7
tab stop creating 7-3
tab stops editing and deleting 

7-4
Text 7-7
text flow 7-2

Numbering Basics 7-2
numbering format 7-13
numbering properties 6-42, 7-1
Numbering Properties dialog box 
7-16
Numbering Tab 3-40
Numeric Space 4-6

O

Object Properties dialog box 8-10
Objects Properties dialog box 8-22
online manuals 4-2
Opening a New Document 2-6
overflow line 5-17
Override 3-3
override 1-5
Override Dialog Box and Overrides 
3-4
overrides 2-15, 3-4, 3-5

P

Page Breaks 4-20
Page Dialog Box 1-27
Page Down 1-21
Page Layout 5-2

changing 5-22
Page numbering 7-12
page numbering property 10-27
page numbering variable 7-13
page overflow 5-49
Page Size

changing 5-22
Page Size dialog box 5-22
Page Size drop-down box 2-7
page sizes 5-16

tabloid size 5-16
Page Up 1-21
PageNumber cross-reference 6-49
pages 5-1

Body Page 5-1
Master Page 5-1
Reference Page 5-1
switching 5-2

Pagination 5-2
Pagination dialog box 5-2, 5-3
Pagination Options 5-24
Pagination Tab 3-35
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Paragraph Catalog 2-5, 2-14
Paragraph Commands 3-44
Paragraph Designer 3-29
Paragraph designer 3-1
Paragraph tag 3-1
Paragraph Tags 3-3
paragraph tags 2-5
paragraph’s format and behavior 
2-5
Paragraphs 4-13
PDF 6-26

thumbnails 10-57
PDF Setup for Select Files dialog 
window 10-54
personal dictionaries

new 4-36
Personal Dictionary 4-31, 4-33
Portable Document Format 6-26, 
10-47
pre-defined page size 2-7
pre-designed templates 2-1
Preferences 1-23, 2-1, 2-2
Preferences window 1-3
Print Document dialog box 10-48
Print Document dialog window 
10-49
print drivers 10-48
Print Only to File (Version 6) 
10-51
Print Page Range 10-49
Print to File (Version 7) 10-51
Print to File Progress dialog win-
dow 10-52
Printing 10-49
printing

Even-Numbered Pages 10-49
Last Sheet First 10-49
Low-Resolution Images 10-49
Odd-Numbered Pages 10-49
Print Only to File 10-50
range of pages 10-49
Skip Blank Pages 10-49

Thumbnails 10-49
Product Interface 1-24
professionalism 2-8
ps extension 10-51

Q

Quick Reference Card 4-2
QuickAccess bar 1-3, 1-16, 4-19

common commands 1-16
docked and floating 1-5

QuickAccess Table bar 9-5

R

read only directory 2-13
read-only access 2-8
Reference frame

updating 5-12
reference frame 5-9, 5-12

renaming 5-11
Reference pages 3-42, 5-8
referenced graphics 6-56
refreshing the screen 2-11
Renaming Character Tags 3-26
Renaming Paragraph Tags 3-46
renaming tags 3-10
Reset Window 3-18
Revert to Saved 5-23
rulers 1-25
Runaround Properties 8-23
Runaround Properties dialog box 
8-22
Running H/F 6-5, 6-21
Running Header and Footer vari-
ables 6-3

S

Save As 2-13
Save As command 2-14

Save as PDF 10-47
Save As Version 6 option 2-14
Save File dialog box 2-13
Save icon 2-13
saving files 2-13
Search Basics 4-21
search, find, and replace text 4-20
searches

asterisk 4-24
backslash 4-24
brackets 4-24
caret 4-24
character formats 4-25
clipboard 4-27
dollar sign 4-24
markers 4-27
non-printing symbols 4-25
questionmark 4-24
special characters 4-25
vertical bar 4-24

selecting text 4-9
series label 7-7
Setting Preferences 2-1
shortcut icons 3-2
shortcut keys 3-7
side-head 5-8
single document TOC 10-46
single-sided document 5-3
site dictionary 4-31
Smart Quotes 4-7
Smart Spaces 4-7
Snap option 5-19
source template 2-8
Special Characters 4-2, 4-5
special characters 6-9
Special menu 1-11
Special Spaces 4-5
spell check a document 4-32
Spell Checker 4-7, 4-31
Spell Checker dialog box 4-31
Spell Checker Options 4-32
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Spelling Checker Options dialog 
box 4-32
standalone document 10-34
standard templates 2-10
Standard Templates dialog box 
2-11
standardize naming convention 3-9
Status bar 1-5, 1-21
Style Guide 3-9, 10-2

Chicago Manual of Style 3-9
system colors 4-18
System variables 6-2

T

tab stops 7-3
table anchor 9-14
table breaks 9-68
Table Catalog 9-1
Table Cell Formats 9-31
Table Cell Tab 3-44
Table Continuation variable 9-4
Table Designer 3-1, 9-3, 9-6, 9-8
table editing 1-16, 1-20
Table Editing Bar 1-20
Table float 9-15
Table menu 1-14
Table of Contents 10-34
tables

adding cells 9-32
adding columns 9-32
attributes 9-31
autonumbering 9-66
borderless figure table 9-40
Column Resize dialog box 9-24
combining 9-28
convert a table to text 9-57
Copy or Move Cells 9-49
copy or move columns 9-34
copy or move rows 9-34
Custom properties 9-52
customize cell margins 9-51

cut, copy, paste, or delete 9-12
default 9-2
delete rows or columns 9-33
deleting 9-18
figure tables 9-38
floating 9-15
Format A 9-2
Format B 9-2
format cells 9-49
import a graphic 9-41
inserting 9-7
labeling 9-4
list style example 9-20
manipulate table cells 9-43
Merging Cells 9-49
modifying 9-6
nested 9-44
numbering 9-4
overrides 9-12
properties 9-10
recreating 9-19
resize a column 9-22
rotate a table 9-63
rotate table cells 9-61
row height 9-58
Ruling tab 9-10
Selecting table cells 9-48
Snap mode 9-24
sorting cells 9-59
splitting 9-26
tab within a cell 9-48
working with 9-14

tag names 3-3
tags 3-1
technical writing 3-1
Template

opening 2-10
template documentation 2-18
Template Uses 2-9
Templates 2-8
templates 2-1
text editing 1-16

Text Editing components 1-17
text flow 3-41, 4-1

correcting 5-17
Flow A 4-1
malfunctioning 5-17

text flows 5-2, 5-15
Text Frame tool 5-19, 5-35
Text frames

tagged frame 5-15
text frames 2-14, 5-2

background 5-15
template 5-15
untagged frame 5-15

Text Inset 8-51
text insets

Convert to Text option 8-54
Text Line tool 4-8, 5-10, 5-11
Text lines 4-8
Text Manipulation 1-3

Limitations 1-3
text search 4-23
text symbols 1-25, 2-14
Thesaurus 4-42
Thesaurus dialog box 4-43
Thesaurus Look Up dialog box 
4-44
Thin Space 4-6
TOC file 10-37
toolbars 1-5
Tools Palette 4-8, 5-9, 5-35
Translation Errors 1-24
Types of Searches 4-22

U

Unanchored Frame Properties 8-21
unanchored graphic frame 8-16

creating 8-20
undo 1-3

multiple undo’s 1-3
Undo Command 1-3
uneven columns 5-26
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Units of Measure 1-23
changing 1-26

unresolved cross-reference 6-26, 
6-37, 6-53
Unresolved Cross-Reference error 
message 6-52
unresolved cross-references 4-29, 
6-48, 6-58
update book file formats 10-19
Update Cross-Reference dialog box 
6-33
User variables 6-4

V

Variable dialog box 6-4
Variables 2-16, 6-1

basics 6-2
building blocks 6-1
case sensitivity 6-9
changing definition of 6-4
color of 6-8

common use of 6-2
Convert to Text 6-7, 6-49
default settings 6-13
default values 6-3
dictionary style 6-15
editing 6-5
examples of 6-2
exceptions 6-2
formatting 6-10
imported 6-4
inserting 6-5
name and definition 6-4
replacing 6-7
Running H/F 6-12
spell checking 6-2
system 6-2
updating 6-8
user 6-2
working with 6-9

View menu 1-11
View Options dialog box 8-12
viewing area 1-21

W

wildcard character 4-24
Wildcard Searches 4-24
wildcards 4-29
Window Guides 1-23, 1-25
Window menu 1-15
Windows-style keyboard com-
mands 1-3
WMF file 8-34
word processor 2-1
Word Spacing 3-44

Z

Zoom Commands 1-21
Zoom Menu Options

dialog box 1-22
zoom pop-up menu

set command 1-22
zoom settings 1-22




